## Revision History

<table>
<thead>
<tr>
<th>VERSION</th>
<th>DATE</th>
<th>PRIMARY AUTHOR(S)</th>
<th>REVISION/CHANGE</th>
<th>PAGES AFFECTED</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
<td>15 APR 2022</td>
<td>DISA RME</td>
<td>Updated for new release</td>
<td>2-10</td>
</tr>
<tr>
<td>1.5</td>
<td>30 APR 2020</td>
<td>DISA RME</td>
<td>Added new content</td>
<td>4 and 19</td>
</tr>
<tr>
<td>1.4</td>
<td>15 JAN 2020</td>
<td>DISA RME</td>
<td>Added new content</td>
<td>11, 19, and 20</td>
</tr>
<tr>
<td>1.3</td>
<td>10 OCT 2019</td>
<td>DISA RME</td>
<td>Added new content</td>
<td>10, 16, and 17</td>
</tr>
<tr>
<td>1.2</td>
<td>7 JUL 2019</td>
<td>DISA RME</td>
<td>Added new content</td>
<td>7 and 8</td>
</tr>
<tr>
<td>1.1</td>
<td>30 APR 2019</td>
<td>DISA RME</td>
<td>Added new content</td>
<td>Various</td>
</tr>
<tr>
<td>1.0</td>
<td>31 JAN 2019</td>
<td>DISA RME</td>
<td>Original Draft</td>
<td>All</td>
</tr>
</tbody>
</table>
# Table of Contents

1 Introduction .................................................................................................................. 1  
1.1 Purpose ...................................................................................................................... 1  
1.2 About the SRG/STIG Applicability Guide ................................................................. 1  

2 Unpacking and Launching the Application ..................................................................... 2  
2.1 Windows .................................................................................................................... 2  
2.2 Linux .......................................................................................................................... 2  

3 Menu Bar ...................................................................................................................... 4  
3.1 File Menu .................................................................................................................. 4  
3.2 Help Menu ............................................................................................................... 4  

4 Navigation Bar Menu .................................................................................................. 5  
4.1 Overview ................................................................................................................... 5  
4.2 Current Button ......................................................................................................... 5  
4.3 New Button .............................................................................................................. 5  
4.4 Load Button ............................................................................................................. 5  
4.5 Merge Button .......................................................................................................... 5  
4.6 Save Button ............................................................................................................. 6  
4.7 Export Button ......................................................................................................... 6  
4.8 Exit Button .............................................................................................................. 6  

5 Right-Click Menu ....................................................................................................... 7  
5.1 Menu ....................................................................................................................... 7  

6 Asset Tree .................................................................................................................... 8  
6.1 Overview .................................................................................................................. 8  
6.2 Adding Assets (Standard Mode) ............................................................................... 8  
6.3 Adding Assets (Guide Mode) .................................................................................. 10  
6.4 Adding Parent Assets .............................................................................................. 12  
6.5 Adding Parent Assets (Guide Mode) ....................................................................... 13  
6.6 Editing Assets ......................................................................................................... 15  
6.7 Removing Assets .................................................................................................... 16  

7 Save, Open, and Merge ............................................................................................... 17  
7.1 Overview .................................................................................................................. 17  
7.2 Save Collection ....................................................................................................... 18
7.3 Open Collection .................................................................................................................18
7.4 Merge Collection ...............................................................................................................19
  7.4.1 Merge an Asset Collection .............................................................................................20
  7.4.2 Merge Collections (with tree not empty) ......................................................................20

8 Drag and Drop ......................................................................................................................21
  8.1 Overview ..........................................................................................................................21
  8.2 Drag and Drop Assets ......................................................................................................21

9 Exports ................................................................................................................................22
  9.1 Overview ..........................................................................................................................22
  9.2 Preview .............................................................................................................................23
  9.3 Exporting ..........................................................................................................................23
  9.4 Scenario ...........................................................................................................................24
1 Introduction

1.1 Purpose
The purpose of the document is to familiarize users with the SRG/STIG Applicability Guide and its functions.

1.2 About the SRG/STIG Applicability Guide
The SRG/STIG Applicability Guide allows users to build a collection of assets pertaining to an environment, such as an information system. Using the collection of assets built by the user, the tool will determine the SRGs, STIGs, and other policy documents the user needs to harden or assess their environment. The tool allows users to preview and export the policy documents as well as import and export the collection.

Application functions include the following:

- Select from two modes of asset addition for different levels of familiarity.
- Drag and drop assets in the asset tree.
- Import and export asset collections.
- Export policy documents.
- Preview policy documents.
2 Unpacking and Launching the Application

The SRG/STIG Applicability Guide will be downloaded in the form of a .zip file. This file must be unpacked before it can be used. These steps will only need to be performed initially. Follow the steps below according to the operating system that will be used.

2.1 Windows

1. Download the STIG Applicability Guide Windows file from (public.)cyber.mil. Double-click the .zip file provided and click Compressed Folder Tools >> Extract all. Place the files from the .zip file into a folder.

![Compressed Folder Tools](image)

2. Double-click the file titled “STIGApplicabilityGuide.exe”.

**Note:** Some Windows systems will not allow the application to be run under C:/Users (Downloads/Documents/etc.), so a new folder may have to be created elsewhere.

2.2 Linux

1. Download the STIG Applicability Guide Linux from (public.)cyber.mil. Double-click the .zip file provided and click “Extract” on the top left.

![Extract](image)

2. Create and name a new folder.
3. Open the newly created folder. On the top left, navigate to Files >> Preferences.


5. Double-click the file titled “STIGApplicabilityGuide.exe” to open it.
3 Menu Bar

3.1 File Menu

The File Menu allows users to Open, Save, or Save As asset collections or navigate to the Preferences page.

3.2 Help Menu

The Help Menu contains information about the application, including the version number, release notes, a list of the application’s dependencies and their licenses, and the ability to check for the latest version of the application.
4 Navigation Bar Menu

4.1 Overview

The navigation bar (Navbar) will display a list of buttons that can be used to interact with the application and the created collection. Depending on the current view in the application, the buttons available on the navigation bar will change. When viewing a collection, more buttons will appear, such as Save, Merge, etc. Clicking the hamburger icon (three lines) at the top will expand/collapse the buttons on the navigation bar.

4.2 Current Button

Click this button to navigate back to the collection that is currently open.

4.3 New Button

Click this button to navigate to the Create Collection view to name and create a new collection.

4.4 Load Button

Click this button to open a file dialog, select a collection file to load into the application, and view/edit it. This is explained below in more detail.

4.5 Merge Button

Click this button to open a file dialog and select a collection file to merge into the collection that is open. This is explained below in more detail.
4.6 Save Button
Click this button to open a file dialog, name the collection file, and save it to disk. This is explained below in more detail.

4.7 Export Button
Click this button to expand the export button into four options. These are explained below in more detail.

- Export
- Assets as Text
- Assets as HTML
- STIGs as Text
- STIGs as HTML

4.8 Exit Button
Click this button to close the application. You will be prompted to save the collection if it is unsaved.
5 Right-Click Menu

5.1 Menu

Right-clicking on an asset will provide a menu. This menu has shortcuts to add an asset, edit the asset, remove the asset, and enter Guide Mode. The right-click menu also includes two features that are not available elsewhere: Add Parent and Add Parent using Guide Mode. Please note that these two features are only available if the selected asset and its current parent have matching assets.
6 Asset Tree

6.1 Overview

The portion of the application under the file menu to the left is the Asset Tree. This allows users to view their current collection and add, edit, or remove assets. The pane to the right is where users are prompted and details of the application are selected.

To begin adding assets, click the “New Collection” button on the dashboard. Enter a name for the collection and then press “Create”.

6.2 Adding Assets (Standard Mode)

1. Click the “+” button to add the first Asset.
A selection pane will appear to the right. Enter the Asset Name and then select the Asset Type (top right) that applies to this asset.

2. Descriptions will be available for each asset type. Selecting the most fitting label* or labels (bottom left of the right pane) that apply to the chosen asset type will be necessary. Search for the label by keying in the name and then selecting it from the list. When done, click “Create” to create an item on the asset tree representing that item.

*Asset Label: A descriptive tag that applies to an asset type.
6.3 Adding Assets (Guide Mode)

1. Click the question mark next to the “+” button to begin Guide Mode.

2. After clicking the Guide Mode button, a pane will appear to the right prompting you to add an asset by asking a series of questions. Answer “Yes” or “No” to each appropriate question and select “End Guide” when finished.
3. Selecting “No” will move to the next asset in the list. Selecting “Yes” will move to the label pane where name and the asset type label can be selected (if available).

After adding and creating an asset, the wizard will descend into its children. The next prompt will be the first child of the asset just added. Once a decision is made to add each child, the wizard will return to the top level and other assets can be added. This process continues until every asset type available has been worked through.

Notes:
- Selecting multiple labels will create multiple tree items with the different labels selected.
- To leave Guide Mode, click “End Guide”.

April 29, 2022
6.4 Adding Parent Assets

If an asset has been created and reverse order is desired (or a parent/child relationship is desired), a parent can be added by using the “Add Parent” feature.

**Note:** The “Add Parent” feature will only be available if the selected asset and its current parent have matching assets.

1. Right-click the asset to add a parent to and select “Add Parent”.

![Image of asset collection with options]

2. Select the asset to add and click “Create”.

![Image of SRG/STIG Applicability Guide with asset creation interface]

**Note:** On the right is the list of assets available based on the asset selected and its current parent.
3. The new parent will be added to the asset.

6.5 Adding Parent Assets (Guide Mode)

If an asset has been created but reverse order is desired, a parent can also be added using the Guide Mode by clicking the “Add Parent” option when selecting Guide Mode.

**Note:** The “Add Parent” feature will only be available if the selected asset and its current parent have matching assets.

1. Right-click the asset to add a parent to and select Guide Mode >> Add Parent.
2. On the right, Guide Mode will walk through available asset labels based on the asset selected and its current parent.

3. Select “Yes” on the Asset Type, give it a name, select the label to add, and click “Create”.

![Guide Mode - Virtual Machine](image1)

![Create Asset](image2)
4. The new parent will be added to the asset. Click “End Guide”.

6.6 Editing Assets

After creating an asset, the asset can be edited using the pencil icon on the tree item for that asset.

1. Click the pencil icon to begin editing an asset. A pane will appear on the right side with the current asset information.
2. The name of the asset and the label (if available) can be changed. After making the required changes, click “Save”.

3. The changes will be reflected on the tree to the left.

6.7 Removing Assets
To remove an asset, click the “x” button on the tree item.
7  Save, Open, and Merge

7.1  Overview

When an asset posture has been built, the application allows users to save the Collection as a JSON document and later import it again. These options can be found under the “File” menu.
7.2 Save Collection

1. To save a collection: In the Navbar, select “Save”.
   
   **Note:** Clicking File >> Save will also work.

2. A window will pop up allowing the option to choose a save location as well as a file name if this is a new collection. Click “Save” to save the collection.

7.3 Open Collection

1. To open an Asset Collection (either JSON or XML): In the Navbar, click “Load”.
   
   **Note:** Clicking File >> Open will also work.
2. Navigate to the location of the saved Asset Collection document, select it, and click "Open".

![Image of folder with Asset Collection document]

3. The asset collection will be opened but collapsed.

![Image of asset collection]

**Note:** If an imported asset has been sunset or deprecated, an indicator will be displayed next to the asset to notify the user. A “sun” indicator signifies that it is sunset. To view sunset assets names, the Sunset Labels option must be enabled. To enable this option, click File >> Preferences and check “Enable Sunset Labels”.

7.4 Merge Collection

Merging an asset collection allows users to import assets from an asset collection file into the currently open collection. When the merge operation is successful, the assets of the merged collection will be appended to the end of the current collection.
7.4.1 Merge an Asset Collection

1. In the Navbar, click “Merge”.

2. Navigate to the location of the saved Asset Collection document, select it, and click “Open”.

7.4.2 Merge Collections (with tree not empty)
8 Drag and Drop

8.1 Overview

The SRG/STIG Applicability Guide is drag and drop enabled, meaning that users can drag and drop a compatible asset into another asset.

8.2 Drag and Drop Assets

To drag and drop an asset, left-click, hold down with the left mouse button, and drag it to the intended asset. When the dragged asset encounters a compatible asset, the compatible asset will turn green, signaling a valid drop location. If the asset is not compatible and the dragged asset is dropped there anyway, the asset will not be moved and a message will be displayed.
9 Exports

9.1 Overview

After building an asset collection, users can export the requirements/policy documents using options in the Navbar menu. Exports come in two file types, HTML and Text, and in two varieties, normal/flat and asset-based list. The flat list contains only the policy documents and their information, whereas the asset-based list also contains the asset that it applies to and the path to get to that asset.
9.2 Preview

To access a preview of the current collection: In the asset tree, select the “Documents” button. The window on the right will show a list of the Requirements/Policy Documents that apply to the current asset posture.

9.3 Exporting

1. To export assets: In the Navbar, select Export Assets as Text (or as HTML).
2. In the window that pops up, choose the location and name of the export file. Click “Save” to save the file.

Examples:
9.4 Scenario

A task is required to secure a system on a VMware-based cloud environment. The VM is running Windows 10 and has several applications installed, including JRE 8, Microsoft Office 2016, .Net Framework 4.0, and an HBSS Agent. Securing this system requires knowing what policy documents to follow. Therefore, the SRG/STIG Applicability Guide is used to easily and quickly fill this need.

1. Add a new collection and name it accordingly.

   Cloud VM Collection +

2. Add a Cloud Service Asset. (For this scenario, use Guide Mode.)
3. Add a VM. (Note: This may require clicking “No” to a few prompts before being prompted to add a VM.)
4. Add the Windows 10 operating system.
5. Add the necessary applications (JRE 8, Microsoft Office 2016, .Net Framework 4.0, HBSS Agent). Select each one individually. After one is selected, it will return to the Guide Mode Application screen. After all of the desired applications have been selected, click “End Guide”.

6. Now that building the collection is finished, policy documents can be previewed by selecting the document icon at the top-most level (last one on right).
April 29, 2022

7. To save the collection, click “Save” on the Navbar.

8. On the Navbar, select Export >> STIGs as HTML. Choose an appropriate name and location and click “Save”.

File name: Cloud VM Collection.json
Save as type: Collection Files (*.json)

Hide Folders

File name: Cloud VM Collection_STIGs.html
Save as type: Requirement Documents Files (*.html)

Hide Folders
9. The exported document should look like this:

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Document Benchmark ID</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>HBSS_McAfee_Agent_STIG</td>
<td>HBSS_McAfee_Agent</td>
<td><a href="https://iase.dina.mil/stigs/hbss/Pages/index.aspx">https://iase.dina.mil/stigs/hbss/Pages/index.aspx</a></td>
</tr>
<tr>
<td>Java Runtime Environment (JRE) version 8 STIG for Windows</td>
<td>JRE_8_and_Windows_STIG</td>
<td><a href="https://iase.dina.mil/stigs/Pages/a-z.aspx">https://iase.dina.mil/stigs/Pages/a-z.aspx</a></td>
</tr>
</tbody>
</table>